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What is Print Code As You Want

Print Code As You Want is a tool to help you to print your Visual Basic code as you want it to look. This 
program has the following features;

1. You may individually set the fonts for your codes description, declarations, code, comments, 
procedure names, headers, and footers.

2. Procedures can be selected for printing from a module, a form, or the project files.

3. The last three opened files are recorded and you may open them by clicking on their names under the
File menu.

4. Your code can be viewed before selecting which procedures to print.

5. When a line of your code exceeds the paper width, it will be word wrapped. You can set the line 
indent character string and a line wrap indicator.

6. The top, left, bottom and right margins are adjustable.

7. A maximum of five lines can be defined in both the header and footer. These can be left, center, or 
right aligned. The date and time formats are also editable.

8. You can specify one procedure per page or continuous printing.

9. You can specify a separator line between procedures.

10. The procedure name can be printed at the top of each page.

11. You can choose whether to print your form declarations.

12. You can choose to print bracket connectors for control structures like Do/Loop, For/Next, etc. This 
very clearly outlines the structure of your code.

13. You can specify Auto Indent and adjust the indent level.

14. You can print the project file contents with file information such as size, file date, etc..

15. You can select a part of your code to print from Selected File Contents Window.

16. Procedure Index can be Printed with or without page.

17. A maximum of 12 naming convention can be defined in the Variable Prefix and Suffix

18. You can select all or changed and added procedures in the project file by one click.



Configuration

After installing the program, you can set it up as you like, following these procedures:

1. First, select Print Menu and then Select Printer.

2. After selecting the printer, select the font, size, and style for your Description, Declarations, Procedure
Name, Comments, and Code from the Page Setup window.

3. Edit the header and footer settings by clicking on the Header and Footer buttons in the Page Setup 
window.

4. Edit Variable naming conventions by clicking on the Prefixes or Suffixes button in the Page Setup 
window.

5. You can set other options, such as line wrap , auto-indent settings and the date and time formats from
the Option Setting window. 

6. Once you have configured Print Code As You Want, click on Save to record your settings.



Limitations

1. Print Code As You Want can only read ASCII text files, so you should save all of your files in ASCII 
format before using this program.

To convert individual files to ASCII format, select Save file as item in the File menu in Visual Basic 
and set Save as text to True

To have all files saved in ASCII format, select Environment under the Options menu in Visual Basic 
and set Default Save As Format to Text.

2. Print Code As You Want only targets black and white printers. It doesn't support color.

3. The header and footer edit dialogs don't show exactly how they will be printed.

4. If a procedure is longer than 96K (approximately), you can't view all of its code.

5. Print Code As You Want Auto Indent and Bracket Connector function doesn't work correctly when 
you use Next statement with the format NEXT K,J,I instade of Next K: NextJ: Next I



How To Use

You can print your code by either selecting one or more procedures or you can print part of a procedure.

To print one or more procedures:

1. You may select one of the File Menu Commands and open a project, module, or form. Alternatively, 
you can just click on the filename of the last three files printed that are listed under File Menu 
Commands.

2. When a project file is opened, the Project File Contents window will come up. Just select one of the 
files.

3. The Procedure List window will come up. Just select the procedures you want to print.

4. The selected procedures are copied to the Selected List window.

5. Select Print Marked Procedures from the Print Menu

To print all or changed and added procedures in a project file:

1. Select File Menu Commands and open a project. Alternatively, you can just click on the project 
filename of the last three files printed that are listed under File Menu Commands.

2. Select All In The MAK File or Changed Procedures from the Mark

3. Select Print Marked Procedures from the Print Menu

To print changed and added file in a project file:

1. Select File Menu Commands and open a project. Alternatively, you can just click on the project 
filename of the last three files printed that are listed under File Menu Commands.

2. Select Changed And Added Files from the Mark

3. Select Print Marked Procedures from the Print Menu

To print part of a procedure:

1. You may select one of the File Menu Commands and open a project, module, or form. Alternatively, 
you can just click on the filename of the last three files printed that are listed under File Menu 
Commands.

2. The Procedure List window will come up. Double click on a procedure name.

3. The Selected File Contents window will show your selected procedures code.

4. Highlight    part of the code and select Print Selected Code from the Print Menu



File Menu Commands

Select .Mak File/Select .Frm File/Select .Bas File
Use these commands to open project, form, or module files.

Exit
Quit Print Code As You Want.

File Name Array
The last three files that you have selected are listed. You can select those files by clicking on their 
filenames.



Mark Menu Commands

These items are available only when project file is selected in the File Menu Commands.

All In The MAK File
All procedures in a project file are copied to the Selected List window.

Changed And Added Files
All procedures of changed and added files in a project file are copied to the Selected List window If 
Changed Procedure Auto Check in the Option Setting window isn't set to True, this function doesn't 
work. Also, It doesn't work when a backup file doesn't exist.

Changed Procedures
Changed and added procedures in a project file are copied to the Selected List window If Changed 
Procedure Auto Check in the Option Setting window isn't set to True, this function doesn't work. Also it 
doesn't work when a backup file doesn't exist.



Print Menu Commands

Setup Printer
Selecting this causes a standard Windows dialogue box to appear, allowing you to change your printer.

Page Setup

Print Marked Procedure
This prints the selected procedures. This item is available only when one or more procedure is selected 
and listed in the Selected List window.

Print Selected Code
This prints a selected part of your code and is available only when a part of your code is highlighted in the
Selected File Contents window.

Print Code As You Want uses a check mark to indicate the settings below. These settings are also 
available from Page Setup

Exclude Form and Control Description
If you don't want to print out the form and control descriptions, check this.

New Page Each Procedure
If you want a page break between all procedures, check this. Please note that if you check this option, 
you can't set Procedure Split Line Style.

Procedure Name On Each Page
If you want to print the procedure name on each page (when longer than one page), check this.

Print Procedure Index
If you want to print the procedure index, check this. You can set index style option in the Option Setting 
window

Bracket Connecting
If you want brackets drawn that connect structures with matching Do/Loop, Case/End Select, For/Next, 
etc., check this.

Auto Indent
If you want your code to be auto indented, check this. When you select Bracket Connecting, Auto Indent 
is set automatically. You can set index columns number in the Option Setting window



Window Menu Commands

Cascade / Tile / Arrange Icon
These functions are the same as in other Windows programs. Please note that Tile means vertical tiling.



Help Menu Commands

Content / Using Help
These functions are the same as in other Windows programs.

Registration
Shows the Registration window

About
Shows the copyright notices.



Registration

Registration Form

If you like this program and keep use it for longer than 21 days, we ask that you support its development
by sending us the registration fee $40.00 (US) and $5.00(US) for shipping and handling. When we 
receive your registration fee, your registration number will be sent to you by E-mail or fax. In addition, the 
latest version will be forwarded to you by E-mail (if you registered using Shareware Registration database
on CompuServe) or by 3.5" diskette through the mail.

There are several ways to register.

1. Register using the Shareware Registration database on CompuServe.(GO SWR). 
This program's Registration ID is 4089.

2. Charge your Visa or Master Card
Call NorthStar Solutions at 1-800-699-6395 from 10:00 a.m. to 10:00p.m., Eastern Standard 

Time. Or send fax the registration form to NorthStar Solutions at (803) 699-5465. 24 hours a day, 7 
days a week.
NorthStar Solutions also accepts registrations via CompuServe (71561,2751) or the Internet 
(71561.2751@compuserve.com).

3. Send your check or money order to:
NorthStar Solutions
P.O. Box 25262
Columbia, SC 29224

Regardless of how you register, please have the following information ready:

The program and version number (Print Code As You Want version 3.0b) you are registering.
Where the latest version should be mailed.
Your Visa or Master Card # and its expiration date (if using Visa/MC)
Your drive types, 5.25 or 3.5 inch

Note:
NorthStar Solutions processes registrations only, please contact the author
for any product/technical support.



Support

If you need support, have comments or suggestions or need to report bugs, please contact me by 
CompuServe or fax.

CompuServe: 72233,643
InterNet: 72233.643@compuserve.com
Fax: 1-604-683-8997
Tel: 1-604-689-8345
Attention: Mr. Koichi Kato



Registration Form
Print Code As You Want Version 3.0b Registration Form

Please send this order form with check or international postal money order to:
NorthStar Solutions
P.O. Box 25262
Columbia, SC 29224

Or

fax with your Visa or Master Card information to
NorthStar Solutions
(803) 699-5465

Print Code As You Want Single Copy    
________    copies at US$40.00 =__________
Shipping and handling 
US$5.00  =__________

Total payment =__________

Program Name: Print Code As You Want 
Version No.: 3.0b

Name: __________________________________________ Date: ____________

Payment Method: Visa    / Master Card    / Check    / money orders (Pls. Mark one of them)

Visa or Master Card number:__________________________(If using Visa or Master Card)

Expiration date:________________(If using Visa or Master Card)

Company: _________________________________________________________________

Address: _________________________________________________________________

City, State, Zip: _________________________________________________________________

Country: _________________________________________________________________

EMail address: _________________________________________________________________

Fax No.: _________________________________________________________________

Where did you obtain Print Code As You Want? _______________________________

Comments or suggestions:

______________________________________________________________________________



Project File Contents window

This window shows all of the form and module file information contained in the selected project file. If 
Changed Procedure Auto Check in the Option Setting window is set to True, one of the following marks 
will be placed at the top of file information.
<C>; Changed file since last use in this application
<N>; Added file since last use in this application

Click one of the form or module names to show the Procedure List window

This window has the following command buttons.

Properties
Click here to examine the project file's property settings.

VBX, etc.
Click here to list the .VBX files (and other non-printable files) contained in the project.

Print.MAK
Click here to print the contents of the project file, including file dates and sizes.

Close
Click here to close this window



Procedure List window

This window shows all of the procedures contained in a selected file. If Changed Procedure Auto Check
in the Option Setting window is set to True, one of the following marks will be placed at the top of 
procedure name.
<C>; Changed file since last use in this application
<N>; Added file since last use in this application

 From this window, you can

1.Select one or more procedure to print.

To select a procedure, click its name. If you want to de-select a procedure, click it again.

2.View a procedure code.

To view a procedure code, double click its name.

This window has the following command buttons:

Cancel
Close this window.

Select All
Click this button to select all of the procedures.

Clear All
Click this button to de-select all selected procedures.

Done
After you have selected all of the procedures you want to print, click this button. The selected procedures 
are then copied to the Selected List window

Print List
Click this button to print procedure list.
You can also print the Procedure Index when printing a code by setting the Print Index Option from Page 
Setup



Selected File Contents window

This window shows a selected procedure's code. Not only can you examine its code, but you can also 
select part of the code to print. To print part of the code, highlight what you wish to print, then select Print 
Selected Code from the Print Menu 

This window has only one command button.

Close
Close this window.



Selected List window

This window shows all of the selected files and procedures in an outline list box. When you select Print 
Marked Procedures from Print Menu , these procedures are printed.

By clicking the plus mark at the left of the filename, the selected procedures appear. If you want to show 
only the filename, click the minus mark at the left of filename.

This window has the following command buttons:

View Code
After clicking a file or procedure name, click on this button to examine the code before printing. If you 
clicked on a filename, you will see the code from the top of the file. If you clicked on a procedure, you will 
see the code for that procedure.

Remove
In order to de-select an item so it is not printed, click the file or procedure name and then click this button.



Page Setup

This window allows you to configure the page layout as follows.

Font Selection
Select the Font, Size and Style individually for your codes Description, Declarations, Procedure Name, 
Comments, Code and Visual Basic Key Word.
To select Header's or Footer's font, click Header or Footer Button.
If you want to print all variables starting or ending with a predefinded character string in a different font, 
Prefix or Suffix characters and Fonts can be set in the Set Variable Prefixes window. or Set Variable 
Suffixes window. To do so, Click Prefixed or Suffixes button. To enable this option, you have to set 
Naming Convention Prefixes and/or Suffixes to True in Option Setting window.

Margin
Set the Top, Left, Right and Bottom margin in inches by typing a value or using the spin buttons. The 
spin buttons increase and decrease every 0.5 inch. The acceptable range is between 0.0 and 3.5 inches. 
The margin will be set in the physical print area on the paper. That means that if your printer can't print 
within 0.25 inches from the top of the paper and you set the top margin to 0.25 inches, the first line will 
appear at 0.50 inches from the top of the paper. Please consult your printer manual about its print area.

Exclude Form and Control Description
If you don't want to print out the form and control descriptions, set to True.

New Page Each Procedure
If you want a page break between all procedures, set to True. Please note that if you check this option, 
you can't set Procedure Split Line Style.

Procedure Name On Each Page
If you want to print the procedure name on each page (when longer than one page), set to True.

Print Procedure Index
If you want to print the procedure index, set to True. You can set the index style option in the Option 
Setting window

Bracket Connecting
If you want brackets drawn that connect structures with matching Do/Loop, Case/End Select, For/Next, 
etc., set to    True.

Auto Indent
If you want your code to be auto indented, set to True. When you select Bracket Connecting, Auto Indent 
is set automatically. You can set index columns number in the Option Setting window

Procedure Split Line
If you want to draw a line between each procedure, set to True. Please note that you can't use line 
separators if you check the New Page Each Procedure option.

This window has the following command buttons:

Cancel
Click here to reset all setings to the defaults.

Options..
Click here to open the Option Setting window.



Prefixed
Click here to open the Set Variable Prefixes window.

Suffixes
Click here to open the Set Variable Suffixes window.

Header
Click here to open the Header Edit window.

Footer
Click here to open the Footer Edit window.

Save
Saves your settings. The Page Setup window will be closed.



Header Edit window

You can specify a maximum of five lines in a header with left, center and right alignment, as follows:

1. Click on a left, center, or right field on lines one through five in the list box shown at the top of this 
window.

2. Enter your own text or select one of seven pre-defined items.

3. Select the header font, then click the Done button. If you want to clear the selected field, click the 
Delete button.

4. When you are finished, click the Exit button.

You may also select the separator line style with the Separator list box. The separator line is drawn 
between the header and the body of the page.



Footer Edit window

You can specify a maximum of five lines in a footer with left, center and right alignment, as follows:

1. Click on a left, center, or right field on lines one through five in the list box shown at the top of this 
window.

2. Enter your own text or select one of seven pre-defined items.

3. Select footer font, then click the Done button. If you want to clear the selected field, click the Delete 
button.

4. When you are finished, click the Exit button.

You may also select the separator line style with the Separator list box. The separator line is drawn 
between the body of the page and the footer.



Option Setting window

Page Setup options are as as follows:

On Line Wrap
When a line exceeds the page width, it is wrapped. If you want to start the second line at the same 
column as the first line, select Indent to First Line. If you don't want to, select No Indent.

Indent Indicator/Wrap Indicator
You may select from a pre-defined string or enter your own string. Indent Indicator and Wrap Indicator will 
automatically add these strings to the beginning and ends of a line when it wraps.

Auto Indent Columns
You can set the indent level from two to ten spaces.

Date /Time Format
Select or enter your preferred format for printing the date and time.

Changed Procedure Auto Check 
If you want to highlight changed and added files and procedures in the Project File Contents window and 
Procedure List window, set to True.
When you set this to True, this program makes a sub directory with the same name as the selected MAK 
file with the extension ".BAK". Copies of each form and module file refered by the selected MAK file are 
made.
To specify the above sub directory location, select one of three options: PCAYW existing directory, 
Selected Project file existing directory, or other location. When you select the third option, Show 
Directories button is enabled. Click this and select the directory in which you want to record the back up 
file.

Procedure Index 
If you want to print index with page, set With Page to True. If you want to print all rather than only selected
procedures, set Include Not Printed Procedures to True.

Naming Convention
If you want to print all variables starting with a predefinded character string in a different font, set Prefixes 
to True.
If you want to print variables ending with a predefinded character string in a different font , set Suffixes to 
True.
When both are selected, prefix has a higher priority than suffix.
Prefix and Suffix characters can be set in the Set Variable Prefixes window. and Set Variable Suffixes 
window.



Set Variable Prefixes window

Set your variable prefix characters up to 12 such as int, str, lng. Then, select the Font, Size and Style 
individually for them.
To cancel one of them, clear Prefix Character column. 
To print all variables starting with definded characters in a different font, you should set Prefixes in the 
Option Setting window



Set Variable Suffixes window

Set your variable suffix characters up to 12 such as %, $, !. Then, select the Font, Size and Style 
individually for them.
To cancel one of them, clear Suffix character column. 
You should set Prefixes in the Option Setting window
To print all variables ending with defined characters in a different font, you should set Prefixes in the 
Option Setting window




